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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this section and 
licensed to you. You acknowledge that the programs may contain third party software (VAR 
applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation 
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail 
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of 
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory 
Management. 

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, 
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags. 

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of 
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization 
application. 

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR 
Applications.  Oracle will not deliver source code to the VAR Applications to you.  
Notwithstanding any other term or condition of the agreement and this ordering document, you 
shall not cause or permit alteration of any VAR Applications.  For purposes of this section, 
“alteration” refers to all alterations, translations, upgrades, enhancements, customizations or 
modifications of all or any portion of the VAR Applications including all reconfigurations, 
reassembly or reverse assembly, re-engineering or reverse engineering and recompilations or 
reverse compilations of the VAR Applications or any derivatives of the VAR Applications.  You 
acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or 
confidential information of the VAR Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall 
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or 
other reduction of the VAR Applications to a human perceivable form.   Oracle reserves the right to 
replace, with functional equivalent software, any of the VAR Applications in future releases of the 
applicable program.
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Send Us Your Comments 
Oracle Retail Space Management, Configuration Guide, Release 13.2. 
Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 
Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 
 Did you understand the context of the procedures? 
 Did you find any errors in the information? 
 Does the structure of the information help you with your tasks? 
 Do you need different information or graphics? If so, where, and in what format? 
 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 
Please give your name, address, electronic mail address, and telephone number 
(optional). 
If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  
If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 
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Preface 
This guide enables you to configure the Oracle Retail Space Management, along with the 
server-side components required for the application.  

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation accessible 
to all users, including users that are disabled. To that end, our documentation includes 
features that make information available to users of assistive technology. This 
documentation is available in HTML format, and contains markup to facilitate access by 
the disabled community. Accessibility standards will continue to evolve over time, and 
Oracle is actively engaged with other market-leading technology vendors to address 
technical obstacles so that our documentation can be accessible to all of our customers. 
For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/. 

Accessibility of Code Examples in Documentation 
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that consists 
solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or organizations 
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Access to Oracle Support 
Oracle customers have access to electronic support through My Oracle Support.  For 
information, visit http://www.oracle.com/support/contact.html or visit 
http://www.oracle.com/accessibility/support.html if you are hearing impaired. 

Related Documents 
For more information on Macro Space Management, see the following documents in the 
Oracle Retail Macro Space Management Release 13.2.3 documentation set: 
 Oracle Retail Macro Space Management Administration Guide 
 Oracle Retail Macro Space Management Administration Online Help 
 Oracle Retail Macro Space Management Configuration Online Help 
 Oracle Retail Macro Space Management User's Guide 
 Oracle Retail Macro Space Management Online Help  
 Oracle Retail Macro Space Management Advanced Users Guide 
 Oracle Retail Macro Space Management Data Importer Online Help 
 Oracle Retail Macro Space Management Release Notes 
 Oracle Retail Macro Space Planning Licensing Information 

For more information on In-Store Space Collaboration see the following documents in the 
Oracle Retail In-Store Space Collaboration Release 13.2.3 documentation set: 
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Customer Support 

 Oracle Retail In-Store Space Collaboration User's Guide 
 Oracle Retail In-Store Space Collaboration Online Help 
 Oracle Retail In-Store Space Collaboration Release Notes 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com
When contacting Customer Support, please provide the following: 
 Product version and program/module name 
 Functional and technical description of the problem (include business impact) 
 Detailed step-by-step instructions to re-create 
 Exact error message received 
 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 13.1) or a later patch release (for example, 13.1.2). If you are installing the base 
release and additional patch and bundled hot fix releases, read the documentation for all 
releases that have occurred since the base release before you begin installation. 
Documentation for patch and bundled hot fix releases can contain critical information 
related to the base release, as well as information about code changes since the base 
release. 

Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technology/documentation/oracle_retail.html
(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 
Documentation should be available on this Web site within a month after a product 
release.  

Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.” 
This is a code sample 
 It is used to display examples of code 
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1 
Configuration Module Overview 

The Configuration Module allows numerous aspects of the operation of Macro Space 
Management to be customized to suit individual users. It also allows directory paths and 
file paths to be specified. 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. If installed, the only part of the Configuration 
Module that affects the operation of In-Store Space 
Collaboration is two paths to Directories. These are 
identified in the section on the Directories Tab.  

 

The effect of changing the majority of the options will be Local - changes will only affect 
how Macro Space Management performs on the individual user's machine. An example 
of this would be setting for how zones, fixtures and merchandise highlight in the 
drawing. The effect of changing the default paths for system and user specified 
directories will be Global – changes will affect all users of Macro Space Management. 
More Info 
The current settings for individual users will be stored in their current Profile. 
The Configuration Module can be accessed from the following components within Macro 
Space Management: 
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Accessing the Configuration Module from the Menu Bar 

COMPONENT 

Admin Module 

Data Import Module 

Fixture Studio 

Merchandiser 

Planner 

Product Studio 

Report Studio 

Accessing the Configuration Module from the Menu Bar 
The full Configuration Module can be accessed from the File pull down menu in the 
individual Macro Space Management modules it is installed in. 
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Accessing the Configuration Module from the Object Browser 

Accessing the Configuration Module from the Object Browser 
Individual tabs of the Configuration Module can be accessed from the Object Browser 
toolbar.  
For example, clicking on the Properties icon in the Object Browser Zones tool bar will 
bring up the Zone options alone – other options cannot be accessed.  

 

 

Full access is generally only available from the main menu bar in the respective modules. 
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Configuration Module Components 

Configuration Module Components 
The Configuration Module contains a series of tabs. Each tab allows changes to be made 
to a specific aspect of Macro Space Management operation. 

 

 The Databases Tab allows details of the connections to the central database to be 
set up. 

 The Options Tab allows some details of the interface with the software to be 
configured.  

 The Directories Tab allows directories where Macro Space Management stores 
data and files to be specified.  

 The Files Tab enables the user to specify where files required for the 
configuration of Macro Space Management are stored.  

 The Zones Tab allows the way Zones are displayed to be specified. 
 The Fixturing Tab enables the way fixtures are inserted into the store plan to be 

configured.  
 The Merchandising Tab enables the way Products and Planograms are selected 

and displayed to be adjusted.  
 The Merchandiser Tab allows the way Merchandiser displays a virtual store to 

be customized. 
 The Profiles Tab allows the adding, editing, renaming and deleting of profiles. 
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Making Changes in the Configuration Module 

Making Changes in the Configuration Module 
Some Configuration Module Changes will significantly affect the way Macro Space 
Management operates.  

Note: If making major changes in the Configuration Module, 
it is recommended that all modules are closed with the 
exception of the Administration Module. The Configuration 
module can then be called from the Administration module 

Global Effects 
If you are a member of the Administrators User Group, changing the directory paths 
(Directories tab) will change those paths for all Macro Space Management users. 
Changes affecting all users of a Specific Computer 
Some of the settings in the Configuration Module are stored in the 
HKEY_LOCAL_MACHINE section of the Registry. These settings affect all users of 
Macro Space Management using that particular computer. 

Changes Affecting Individual Users of MSM 
Some of the settings in the Configuration Module are stored in the 
HKEY_CURRENT_USER section of the Registry. These settings only affect that specific 
MSM user. 

Note: for more information on how specific values in the 
Registry are used by MSM contact Oracle's Technical 
Support Department.  

When Changes take Effect 
Changes made in the Configuration Module will only be written to the database when 
the OK button in the lower right of the dialogue box is clicked. (Clicking the Cancel 
button will exit without saving changes).   

 

If the user makes changes in the Configuration Module, then exits without saving, they 
will be warned about outstanding changes. 

 

Changes made to settings within the Configuration Module will take effect at different 
times.  
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Relationship between Configuration and Admin Modules 

Some settings will have an immediate local effect. Other changes will take effect when a 
new store plan is opened. Other changes will only take effect when Macro Space 
Management is restarted.  

Relationship between Configuration and Admin Modules 
The Administration Module is a part of Macro Space Management only accessible to 
users with Administrative privileges. It contains a series of settings that affect the global 
operation of Macro Space Management. 
Some data is passed between the Configuration Module and the Admin Module – 
changes on one module being reflected in the other. An example would be the Options 
Frame in the Merchandising Tab in the Configuration module. This contains allows 
settings for the % Over Tolerance and % Under Tolerance options controlling the 
permissible variations between Fixture and Planogram sizes.  
These tolerances are also reflected in the System Variable table in the Admin Module – 
changes in one module should result in the change being visible in the other.
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2 
Basic Concepts 

This section explains the basic concepts of Macro Space Management Configuration 
Module. 

Accessing options using the Control Key 
Some commands are accessed by simultaneously pressing the Control, <Ctrl> key, plus 
another designated key.  
In the Help Files, this is shown as (for example) <Ctrl + A>. 
Within the Configuration Module, this is applicable to the Database Tab. 

Profile 
A Profile contains a defined set of preferences that have been set using the configuration 
Module.  
As changes are made to the Configuration Module, the modifications are stored in the 
current profile. Macro Space Management allows users to store multiple profiles, 
allowing them to switch from one set of standard settings to another.  
An example might be the use of two profiles; one for normal operation, and one where 
the user is experimenting with an alternative configuration for Macro Space 
Management. The Profile in use is known as the Current profile. 
Profiles are set using the Profiles tab in the Configuration Module. 

Global Change 
A Global Change is a change made to Macro Space Management that affects all users 
simultaneously – typically a change will be made to parameters stored in the central 
database.  
If, for example, the Update Database option is used in the Configuration Module to 
change the name of a specified database, then all Macro Space Management users will 
read and write information to that new database. 
A record of all current settings is stored in a Profile. 

Local Change 
A Local Change is a change made to Macro Space Management that affects only the 
user’s computer – typically the Registry settings will be changed on that computer. 
Local changes are often made to customize the operation of the software so that it meets 
the user’s individual preferences. An example of this would be enabling or disabling 
Sounds in the Configuration Module.  
A record of all current settings is stored in a Profile. 

Trusted connection 
SQL Server 

   Basic 
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Trusted connection 

A Trusted Connection for SQL Server users is one where access rights are assigned to 
individual users when the connection is first configured. Each subsequent time Macro 
Space Management is opened, SQL Server verifies that the Windows User Name and 
Password currently active is authorized to access the designated server. This removes the 
need for a User Name and Password to be entered into the Database Tab in the 
Configuration module.  
If a connection is not designated as trusted, then a SQL Server user will need to enter a 
valid User Name and Password in the appropriate fields in the Database Tab to connect 
to the database. These will be saved and allow access to the central database each 
subsequent time Macro Space Management is used. 
Oracle Databases 
User ID and Passwords will always be required for Oracle databases. Again, these are 
entered into the appropriate fields in the Database Tab. These will be saved and allow 
access to the central database each subsequent time Macro Space Management is used. 
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3 
Configuration Module Components 

This chapter explains the various components of the Configuration Module. 

Current Configuration Profile 
The Current Configuration Profile is shown above the tabs. Changes made to 
configuration options are stored in this profile.  

 

The current profile can be changed in the Profiles tab.  

The Database Tab 
The Database Tab contains the settings for the database in current use. The lower half of 
the tab is only available to Macro Space Management Administrators and is toggled into 
view by means of <Ctrl + A>. 
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The Database Tab 

 

Note: It is recommended that Administrators supervise 
changes to this tab - connection with the database could be 
lost due to incorrect settings. 

Database connection settings are stored in a Profile (see info on the Profiles Tab). 
Switching Profiles is a quick and easy way of changing the database a user is connected 
to.  

Overview of Connections via the Database Tab 
The Database Tab provides an interface to connect to the database types supported by 
Macro Space Management.  

 

The precise options available will be controlled by which database software has been 
installed. If both SQL Server and Oracle database software has been installed on the 
user's computer, then more options will be available in the drop down lists than if only 
one has been installed.  
The options available in the drop down lists are read from the drivers tab of the ODBC 
Data Source Administrator dialogue box from the Administrators Tools in the Windows 
Control Panel.  
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The Database Tab 

 

As many of these drivers are installed by default when Windows is installed, the drop 
down list in the Configuration Module contains options that are not in use by Macro 
space management.  

Note: When a database type is selected from the Database 
Type drop-down list in the Configuration Module, the 
software sets the Provider Name and Default Name to the 
recommended default. 

Database Connection settings are stored in the Registry, so the settings are specific to that 
computer.  
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The Database Tab 

Setting Connection Options for Oracle Databases 
Oracle Database connections are set as follows: 

 

Note: these setting are saved in the registry of the local 
computer and will thus be valid for all users of that 
computer.  

Database Type 
The Database Type drop-down list enables the user to select the generic type of database 
to connect to. 

  

Select Oracle from the drop down list. 

Data Source 
The data source is the alias for the server that the required database resides on. 

User ID and User Password 
The User ID and User Passwords are the passwords for the Database (not Macro Space 
Management). 
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The Database Tab 

Provider Name 
This should default to OraOLEDB.Oracle for all databases 

Driver Name 
The Driver Name will vary depending on which version of the Oracle database is 
installed. {Oracle in OraHome92} is the driver for an Oracle 9i database. 

Connection Options 
These are only valid for a SQL Server database. 

Connection Time out 
This sets the maximum time before the software determines connection with the database 
has been lost. If the connection time is longer than the default, a warning message will 
appear.  

Command Time out 
This sets the maximum time before the software determines that there are problems with 
the database and the command will not be executed. 

Table Prefix 
This functionality is currently not enabled. 
The Test Connection button checks that the connection to the central database is 
functioning correctly. Clicking on it will bring up a message indicating whether the 
connection is correctly functioning or not.  
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The Database Tab 

Setting Connection Options for SQL Server Databases 
SQL Server Database connections are set as follows: 

 

Note: these setting are saved in the registry of the local 
computer and will thus be valid for all users of that 
computer.  

Database Type 
The Database Type drop-down list enables the user to select the generic type of database 
to connect to. 

  

Select SQL Server from the drop down list. 

Data Source 
The data source is the server that the required database resides on. 

Database Name 
The Database Name is the name of the database it is desired to connect to. 
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The Database Tab 

User ID and User Password 
The User ID and User Passwords are the passwords for the Database (not Macro Space 
Management). 

Provider Name 
This should default to SQLOLEDB.1 for all databases 

Driver Name 
The Driver Name will vary depending on which version of the Oracle database is 
installed. {SQL Server} is the driver for a Microsoft database. 

Connection Options 
These are only valid for a SQL Server database. Trusted Connections use Windows 
authentication to log into the database. Connections can be set to 'trusted' if required by 
using the string TRUSTED_CONNECTION=YES; 

Note: if a trusted connection is in use there is no need for 
User ID or User Password. 

Connection Time-out 
This sets the maximum time before the software determines connection with the database 
has been lost. If the connection time is longer than the default, a warning message will 
appear.  

Command Time-out 
This sets the maximum time before the software determines that there are problems with 
the database and the command will not be executed. 

Table Prefix 
This functionality is currently not enabled. 
The Test Connection button checks that the connection to the central database is 
functioning correctly. Clicking on it will bring up a message indicating whether the 
connection is correctly functioning or not.  

 

The Database Tab and the Registry 
Settings from the Configuration Module are stored in the Registries of individual 
computers. The information is found using the following path: 
HKEY_LOCAL_MACHINE\SOFTWARE\AVT\Retail Focus 5 
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The Database Tab 

 

Each Profile in the Configuration Module (Profiles Tab) has its own entry in the Registry. 
In the above example, data is held for three profiles: 

 Live Database 
 Test Database 
 v5 Default 

Within each profile, there is a RDBMS folder. This holds information on the database 
connection settings. 
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The Options Tab 

 

Note: because information is stored in the 
HKEY_LOCAL_MACHINE section of the Registry, changes 
to the database setting will affect all users of that computer, 
not just that specific user in Macro Space Management. 

Users must be 'Power Users' for the Registry to allow information to be written to the 
Registry every time changes are made in the Configuration Module. 

The Options Tab 
The Options Tab enables a number of broad options to be set up.  

 

The Units frame allows the user to specify which units Macro Space Management will 
use as its default. 
Units can be set to either Metric or Imperial and should be appropriate for the database 
in use. 
Fixture Decimal Precision is the precision that will be used for dimensions in Fixture 
Studio. 
Fixture Numeric Increment is the amount a spin control in Fixture Studio will be 
incremented each time the user clicks on an increase or decrease arrow. 
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The Options Tab 

Product Decimal Precision is the precision that will be used for dimensions in Product 
Studio. 
Product Numeric Increment is the amount a spin control in Product Studio will be 
incremented each time the user clicks on an increase or decrease arrow. 

Note: Fixture Decimal Precision, Fixture Numeric Increment, 
Product Decimal Precision and Product Numeric Increment 
are currently not functional. 

Although Macro Space Management can work in a variety of units, specifying the default 
unit affects some aspects of configuration including the units used for the default 
tolerances and for annotation. The default unit is also the measure used to store 
measurements in the database. 

The Directories Tab 
The Directories Tab contains the list of Directories where Macro Space Management 
stores its information.  

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. If installed, the only part of the Configuration 
Module that affects the operation of In-Store Space 
Collaboration are two paths to Directories. These are the 
paths to the Image Root and the Store Root. 

 

These directories may be: 
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The Options Tab 

 Default: mandatory directories required by the software and configured by 
Oracle. These cannot be renamed or deleted. 

 User Defined: non-mandatory directories defined by the user and used to hold 
information on (for example) fixtures. These can be added to meet customer 
requirements. 

These directories may be located as follows: 
 Central: in a single specific location on a network so that the data in them is 

available for all users 
 Local: in a location specific to the user (often on their hard drive) and normally 

only accessible to that user 
The path to the directory may be specified as either a: 

 Mapped drive: the path name is relative to a folder that has been 'mapped' using 
Windows tools 

 UNC (Uniform Naming Convention) path: the full path to the directory 
 Local Drive: the user's local hard drive 

Note: the directories referenced by In-Store Space 
Collaboration must always be UNC paths - the ISSC service 
does not recognize mapped drives. 

Information on directory paths may be stored as: 
 Default: the standard path to the directory used as the default for all users.    
 User Specific: a path to the directory specific to that user. User specific paths can 

only be set for user defined directories and not for system directories. 

Note: UNC paths are better for Central paths. This is 
because not everyone will have mapped to the same 
directory, whereas a UNC path is common to all users.  

The Directories Tab enables Administrators to configure this information. 

Overview of Directories 
The default directories for Macro Space Management are specified below. They are 
configured by Oracle and cannot be deleted or renamed.  

 Network Directories use a single specific location on a network so that the data 
in them is available for all users. 

 Local Directories use a location specific to the user (usually on their hard drive) 
and normally only accessible to that user. 

Directories should only be designated as Local if there is no possibility of the specific 
data stored there being used by other users. 

Directory 
Name 

Directory 
Type 

Comment 

Archived 
Files 

Network Directory files will be moved to after they have been imported. 

BMP Preferably 
local 

This directory is used for the AutoCAD toolbar button bitmaps 
that appear in the toolbars in the Planner environment. It is 
normally local as the icons are part of the software installation. The 
local files are found at C:\Program Files\Oracle 
Retail\MSM\BMP. 
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The Options Tab 

Directory 
Name 

Directory 
Type 

Comment 

Export files Network or 
local 

Location that files are exported to, for example Profiles 

Icons 

 

Network or 
local 

Directory for additional icons used by Oracle Retail Macro Space 
Management. This directory will be discontinued shortly. 

Image 
Capture 

Network  Default directory for holding images captured by a scanner, digital 
camera, etc. These images can subsequently be imported into the 
software. 

Image Label Network Directory for images that can be added to the labels associated 
with fixtures in the Merchandiser environment.  

Image 
Profile 

Network Location for 2D planogram profile images. The images are used 
when a planogram is placed as a 2D placeholder in the 
Merchandiser environment. 

Image Root Network This is the root directory for the images that will be used for 
photo-realistic indications of products. As product images are 
added, edited or deleted, the hierarchy below the image root will 
be modified.   

Note: Image Root must be a UNC path if referenced by In-Store 
Space Collaboration. 

Import Files Network Location to which files will be imported. Data Importer looks for 
the files it reads in this location.  

Help Must be local The location of the help files used by Macro Space Management. 
 The locally installed files are found at C:\Program Files\Oracle 
Retail\MSM\Help.  

Note: the directory must be local as chm type help files cannot be 
read across a network for security reasons. 

Log Files Network or 
local 

Log files created by the application to record events and issues 

MSM Network Directory that holds standard blocks used by Oracle Retail Macro 
Space Management. It has two sub directories for imperial and for 
metric blocks.  

RFBin Network This holds files that have been marked for deletion in Store 
Manager and moved from their location relative to the Store Root. 
If purged (Store Manager), they will be permanently deleted. If un-
deleted, the files will be moved back to their location relative to the 
Store Root.  

Planogram 
Root 

Network or 
local 

Root directory for planograms imported from third party software. 
This directory is not used in the standard implementation. 
Planograms can only be imported via the Data Importer 

Root Must be local Root directory for the application. For files such as the AutoCAD 
line style or hatch style files 
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Directory 
Name 

Directory 
Type 

Comment 

Store Root Network This is the root directory for the directories and files that make up 
the hierarchy specified in Store Manager. As stores, floors, 
revisions and files and added, edited or deleted, the hierarchy 
below the store root will be modified. 

Note: Store Root must be a UNC path if referenced by In-Store 
Space Collaboration. 

Textures Network Directory for Textures. Used for specifying the textures for walls, 
ceilings, etc in Merchandiser 

Working Normally 
local 

Directory for temporary files, including temporary graphics 
images created in Merchandiser. The pre-installed local directory 
can be found at C:\Program Files\Oracle Retail\MSM\Working 

More information on specific directories can be found in the chapter on directories.    

Overview of Directory Paths 
Directories may be either System or User Defined.  

 System directories cannot be deleted and can only have their paths changed. 
 User Defined directories are additional to the system directories. They can be 

added, edited and deleted.  
Both are set using the Add Directory or Edit Directory dialogue box from the Directories 
tab of the Configuration module. 

Note: Changing a User Specified directory path will only 
change the path for that user. Changing a Default directory 
path will change that path for ALL users. Accordingly, 
changing the Default directory path should be done with 
caution.  
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Directory Name 
 If the directory is a system directory, the directory name will be grayed out and 

non-editable. 
 If the directory is a user defined directory, the directory name can be edited. 

Path Options 
The paths to the directories can take three forms: 

 Mapped drives 
 UNC (Uniform Naming Convention) Paths 
 Local Drives 

Mapped drives and UNC paths are only supported it the appropriate option is checked.  

Location 
Directories can be: 

 Central - on a server, so they are available for all users 
 Local - on a users hard drive, so they are normally only available to that user 

Note: take care when specifying directories as local - the 
majority of system directories need to be available to all 
users. 

Central Path 
A central path is to a directory on a server 

Local Path 
The definition of a Local Path depends on whether it is being created by an Admin or 
Non-Admin User.  
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 If created by an Admin User it is normally a generic path to a directory on all 
local drives, for example the help file directory that is installed at  C:\Program 
Files\Oracle Retail\MSM\Help. 

 If created by a Non-Admin User, it is a path to a User Defined directory. This 
sort of path can refer to a directory on a user's computer or a directory on a 
network. 

Effect of User Group on Directory Paths 
The User Group a User belongs to determines the effect they have when setting directory 
paths. 

 If the User belongs to the Admin (Administrators) User Group, if they change a 
directory path in the configuration module, they change the default path for that 
directory.  

 If the user does not belong to the Admin (Administrators) User Group, if they 
change a directory path, they will create an alternative (personal) path that is 
specific to them. (They can revert to the default path at any time by clicking the 
'Default' button in the directories tab of the Configuration Module).  

 

Admin User 
Admin Users can: 

 Set the default paths for system directories located on the network. 
 Set the default paths to (common) system directories located in individual hard 

drives. (An example would be the help directory - located at C:\Program 
Files\Oracle Retail\MSM\Help on every user’s hard drive). 

 Add and Delete User Defined directories. 
 Set the default paths to User Defined directories. 

Non Admin User 
Non Admin Users can: 

 Add and Delete User Defined directories. 
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 Set alternative (personal) paths to User Defined directories. 

Note: at present Non-Admin users can also set the default 
paths for system directories. Inadvertent changing of default 
directories may cause significant problems with the system. 
Non-Admin users should be careful to only change the local 
paths to User Defined Directories. (See the section on setting 
directory paths). 

Adding, Editing, and Deleting Directories 
Adding Directories 
Only User Defined directories can be added. This is done by clicking the Add button on 
the Directories tab. 

 

This will bring up the Add Directory dialogue box. 

 

This will allow users to configure details for User Defined directories including: 
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 Directory Name 
 Where local or central 
 Path to directory 

 Note: the specified path for the directory must reference a 
directory in the Windows directory structure. 

Editing Directories 
Editing directories is carried out by highlighting the required directory in the list of 
directories and clicking the Edit button. 

 
What can be edited depends on whether the directory is a System or User Defined 
directory. 

 If a System directory, only the path to the Windows directory can be edited 
 If a User Defined directory, the name the directory is identified by and the path 

to the directory can be edited.  

Note: System Directory names will be grayed out and non-
editable. 
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If the directory is User Defined, the name used to identify it can be edited.  
For both System and User Defined directories, the path can be set to be either central or 
local. 

Note: care should be taken if editing system directory paths - 
changing the path may significantly affect functionality 
within Macro Space Management. Paths to directories are 
referenced by other modules – for example Fixture Studio. 
Changing a path may affect the operation of these modules. 

Deleting Directories 
To delete a User Defined directory, highlight the directory Name then click on the Delete 
button. (System directories cannot be deleted). 

 

A small dialogue box will come up asking for confirmation the directory is to be deleted.  
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Click on Yes to delete the directory. 

Admin Users and Directory Paths 
Users belonging to the Admin (Administrators) User Group set the default paths for both 
System and Local directories. 

Note: Anyone belonging to the Admin User Group can only 
reset default paths - they cannot save user specific paths. 

To set a default path, highlight a directory and click the Edit button. 

 

This will bring up the Edit Directory dialogue box. 

Central Paths 
Central paths (which must use mapped drives or UNC paths) are used to point to 
directories that are on a server or other centralized resource. They are used for folders 
that are common to all users - for example directories holding images for use in 
Merchandiser. 
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Note: It is possible to put a path referencing a C: (local) drive 
in the Central path text box. This is not recommended. 

Local Paths 
Local paths are used to point to directories that are in a common location on hard drives 
across the system. An example would be the help files, which are always located at 
C:\Program Files\Oracle Retail\MSM\Help in each installation. 

 

If the default path is set to C:\Program Files\Oracle Retail\MSM\Help, then all Macro 
Space Management users will have their software set to look for the help files in that 
location on their local hard drive.  

36   



The Options Tab 

User Defined Directories and User Specified Paths 
User Defined Directories are used in conjunction with system directories. The purpose 
of the User Specified directories is to hold customer specific information. Examples of 
information held in such directories include: 

 Architectural plans to be copied or linked into Store Manager 
 Blocks used to represent fixtures, etc, referenced by Fixture Studio 
 Reports and other output from Macro space Management 

Unlike system directories, User Specified directories can be added, edited and deleted. 
They can also have user specific paths. 

Note: When adding custom directories, care should be taken 
to determine whether they should be local (specific to a user) 
or system (available to all users). Most custom directories 
will need to be system directories as (for example for blocks) 
they will need to be available to all users of Macro Space 
Management.  

Setting paths to User Defined Directories. 

Note: Non-Admin users should not set (or reset) the paths 
for any system directories. These are directories where the 
directory name is grayed out and non-editable and the 
System Directory check box is ticked in the options frame. If 
Non-Admin users reset the paths to system directories, 
system wide crashes may result. 
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Default and User Specific Paths 
 If the (Non-Admin) user is creating a directory as well as setting the path, the 

path will become the default path for other users. 
 If the directory has already been created, the (Non-Admin) user will create an 

alternative path specific to that user. 
Setting Paths 
To set the path to the User Defined directory: 
1. Set the directory location to Central or Local as required. 
2. Ensure the appropriate 'Support Mapped Drives' or 'Support UNC Paths' check 

boxes are ticked in the Options frame if required. 
3. If necessary, use the radio button on the local frame to set the option to 'Must be on 

Local Machine', 'Must be on Network' or 'Can be Anywhere' 
4. Click the Browse Button and navigate to the required directory. Click the 'OK' button 

to return to the Edit Directory dialogue box. 
5. Click the 'OK' button at the bottom of the Edit Directory dialogue box to add the 

path. 
User Specified Paths 
Non-Admin Users can set alternative paths to User Defined Directories by using the Edit 
Directory dialogue box (providing the directory has already been defined and a default 
path exists in the database).  

Note: Admin Users can only set the default path for all 
users. 

This is done by highlighting the required directory on the Directories Tab of the 
Configuration module and clicking the Edit button to bring up the Edit Directory 
dialogue box. 

 

The Non-Admin User can then set their alternative path to the User Defined Directory. 
On clicking OK, this alternative path will be stored in the central Macro Space 
Management database.  
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Note: think carefully before setting alternative paths. this 
may result in information stored using the alternative path 
becoming unavailable to other users. 

Reverting to the Default Path 

To change back to the default path, highlight the required User Defined directory and 
click the Default button on the Directories tab. 

 

 If there is a difference between the default path and the user specific path in the 
tables, the default button will be enabled. Clicking the button will change the 
User Specific path back to the default one. 

 If there is no difference between the default path and the user specific path in the 
tables, the default button will be grayed out and unavailable. 

Directories 
Following are the different types of directories: 

The Archive Directory 
The Archive Directory is used to hold files that have been processed by Data Importer. If 
the Archive Directory is absent, users will warned on starting up Data Importer. 

 

Files for Data Importer are initially placed in the Import Directory. When using Data 
Importer, the user can set two options in the Import Definitions dialogue box. 
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 If the user checks 'Archive After Import' a copy of the processed file will be 
placed in the Archive directory. 

 If the user checks 'Delete After Import' and 'Archive After Import', a copy of the 
processed file will be placed in the Archive directory and the original will be 
deleted from the Import Directory. 

The BMP (Bit Map) Directory 
The Bit Map Directory is used to hold the bitmaps used for the toolbars in the Planner 
module. The directory should be local on every user's computer. The local files are found 
at C:\Program Files\Oracle Retail\MSM\BMP. 
If bit maps are missing from this directory, the toolbars will have a question mark 
signifying the missing bit maps. 

 

The Export Directory 
The Export Directory is the specified location to export files to. Objects that can be 
exported include: 

Profiles  
Profiles can be exported by clicking the Export button of the Profiles tab in the 
Configuration module.  
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Store Plans  
Store plans can be exported from Store Manager by selecting the store plan and then 
using the Export option in the right click menu. This   

 

The file name will be of the form Store Name_Floor Name_Revision 
Name_Drawing_Name.dwg, enabling the file to be identified. 

Snapshots  
Snapshots are images of the current Merchandiser drawing they are taken using the 
Snapshot option on the view menu. Snapshots  are stored in a hierarchy that starts in the 
image directory that is a sub directory of the export directory. A hierarchy will be created 
below the images directory that mirrors that of the store hierarchy.  
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The Floor Plan Publish Directory 

The Floor Plan Publish directory is used as the starting point for the sub-directories used 
to hold published floor plans. The precise structure of those sub-directories will depend 
on setting in the Output Tab on the Floor Plan Publishing Configuration dialog box in the 
Admin Module. 

 

The Image Capture Directory 
The Image Capture directory holds the images to be imported into Product Studio and 
subsequently used in Merchandiser (if required) as photographic representations of the 
products on the shelves.  
The Image Capture directory can either be set to be on a server (network) or on the user's 
hard drive (local). If on a local drive, the images will only be available to that user and 
not generally available for importing.  
When the image is used, whether it is moved or copied to the Image Root directory will 
depend on the settings in the Product Image Configuration dialogue box (called from the 
View menu). 
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 If the 'Copy file from capture directory to Image Root' option is checked, the 
image will be copied from the Image Capture directory to the appropriate sub-
directory in the Image Root directory.  

 If the 'Copy file from capture directory to Image Root' option is not checked, the 
image will be moved from the Image Capture directory to the appropriate sub-
directory in the Image Root directory.  

The Image Label Directory 
The Image Label Directory is used to store images that will be added as labels to fixtures 
in the Merchandiser module. The images can be of .bmp, .jpg or .png  
The images are inserted in Merchandiser by using the Add (or Edit) options on the 
Formatting Toolbar 

 

This will bring up the Labeling dialogue box.  
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Images that are in the Image Label directory can then be selected from the Image 
dropdown list and added to the highlighted fixture. 

Note: this functionality is not working correctly at present.  

The Image Profile Directory 
The Image Profile Directory is used to hold 2D images of planograms. These are 
generated during the planogram design process in the Merchandiser module (example 
below). 

 

These images will be displayed in the Merchandiser module if: 
 The default mode of placing a planogram has been set to '2D' in the 

Merchandising tab of the Configuration module. 
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 Planograms have been toggled to '2D' mode using the 'Implode' option on the 
Directions and Product Text toolbar in the Merchandiser module. 

The Image Root Directory 
The Image Root directory holds sub-directories containing the images assigned to 
products in the Product Studio module and subsequently displayed (when the 
appropriate settings are selected) in Merchandiser.  

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. If installed, In-Store Space Collaboration 
references the information in the Image Root for Front 
Graphical View. It needs the path to be specified in UNC 
format. 

The names of the sub-directories (and associated images) are dependent on settings  in 
the Product Image Configuration dialogue box (called from the View menu in Product 
Studio). 

 

Note: Information on directories and filenames is not stored 
in the MSM database. It is implied from the settings in the 
Product Image Configuration dialogue box. Accordingly, 
changing settings in this dialogue box may cause problems 
in locating images imported into Product Studio using 
earlier settings. 

Sub Directory Name 
1. SKU Code 
If the SKU code is selected, any value between 0 and 3 can be selected. If 0 is selected, all 
images will be put into the image root without using sub-directories. If a value between 1 
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and 3 is selected, the sub directory will be named after the requisite number of characters 
from the start of the SKU string. 

Note: there is an error in the software. At present the SKU 
code is reading data from the client code field in the 
database, not the SKU field.  

2. UPC Code 
If the UPC code is selected, there are two options for determining the name of the sub-
directories. These are selected via the radio button. 
a. If 'Number of Characters' is selected, any value between 0 and 3 can be selected. If 0 

is selected, all images will be put into the image root without using sub-directories. If 
a value between 1 and 3 is selected, the sub directory will be named after the 
requisite number of characters from the start of the UPC string. 

b. If 'Manufacturer' is selected, the sub-directory will be named after the first five 
characters of the UPC code as these denote the manufacturer. (Any leading zeros will 
be suppressed). 

3. Product Description 
If Product Description is used, the directory name can be anywhere between 0 - 3 
characters long. If 0 is selected, all images will be put into the image root without using 
sub-directories. If a value between 1 and 3 is selected, the sub directory will be named 
after the requisite number of characters from the start of the Product Description. 

Image Name 
SKU codes or UPC codes 
The image file name for items using either SKU codes or UPC codes will be of the same 
format: Display Style Type/Code/Facing Direction. It is assigned automatically when 
the images are added to the Display Styles dialogue box in Product Studio. 
An example of an image file name would be U50781276_1.jpg 
The list of Display Style Types are set in the Display style type’s dialogue box (accessed 
from the View menu in Product Studio). 

 

Note: Display Style Types are assigned to specific products 
in the Display Styles dialogue box in the Product Studio 
module. 
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The Product Code or SKU code will have been assigned to the product, either when it 
was imported, or when it was added in Product Studio (Display Styles dialogue box). 
The view direction can be one of 6 options: 

Direction Value 

Front _1 

Left _2 

Top _3 

Back _4 

Right _5 

Bottom _6 

There can be up to six images stored for each product display style if UPC or SKU codes 
are in use - only the suffix differing in each file name. 

Product Description 
If images are being named after the Product description, there can only be one image 
stored per display style. It will be named after the display style description; for example 
Tinned Peas - 50g.jpg. 

The Import Directory 
The Import Directory is used to store files for use by Data Importer. The Data Importer 
module can only read files from this specific directory and cannot be modified to import 
from files in any other location. If the Import Directory is absent, users will warned on 
starting up Data Importer.  

 

When using Data Importer, the user can set two options in the Import Definitions 
dialogue box. 
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 If the user checks 'Archive After Import' a copy of the processed file will be 
placed in the Archive directory. 

 If the user checks 'Delete After Import' and 'Archive After Import', a copy of the 
processed file will be placed in the Archive directory and the original will be 
deleted from the Import Directory. 

The Help File Directory 
The Help File Directory contains the .chm (Compiled HTML) files used for the on-line 
help for Macro Space Management. The directory must be local on every user's computer 
as .chm type help files cannot be read across a Microsoft Windows network. The local 
files are found at C:\Program Files\Oracle Retail\MSM\Help. 
A typical error from using non-local help files is  below. 
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Note: .chm type help files cannot be used across a network 
as Microsoft believes doing so would create security 
vulnerability. 

The Log Directory 
The Log Directory holds text versions of some of the logs maintained by Macro Space 
Manager. 

 

This directory may be either local or network.  
1. If local, each user will have information written to a user specific help file. 
2. If network, all users will write information to a common help file. 
These log files can be used by Support personnel to diagnose problems with the software. 

Note: Other logs are written to tables in the database. 

The MSM Directory 
The MSM Directory is used to hold standard blocks used by the application. There are 
Imperial and Metric directories and the default directory below   
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These standard blocks include: 

 

 Blocks used for annotating aisles and for bay numbering (i.e. REF-CIRC, 
REF_ELPS, etc) 

 Blocks used to represent modules [2 dimensional blocks used for placing 
merchandise directly on the floor] (I_MODULE) 

 Product Bocks used to represent products on fixtures (i.e. I_PBASE__, IBOX, etc) 
 Title Blocks used for drawing borders (i.e. ANSI_D, ANSI_E, etc) 

Note: Imperial Blocks have a prefix of I_, metric blocks do 
not have a prefix. 

These blocks can be different file types: 

DWG File used in the Planner (AutoCAD 
environment) 

3DS Basic graphics file used in the 
Merchandiser environment 

LWO More advanced graphics file used in the 
Merchandiser environment 
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The Planogram Documents Directory 
The Planogram Documents Directory is used to hold reports imported from third party 
planograming software. These reports can be in multiple forms including BMP, JPG and 
PDF files. 
The name of the imported report is displayed in the Associated Documents field of the 
Planogram Design dialog box in the Merchandiser module. 

 

Note: The name of the report is changed during the import 
process. It is renamed to reflect the ID assigned to the 
Planogram in the database (POG_ID). The name of the 
document displayed in the Associated Documents field of 
the Planogram Design dialog box hold the original path and 
filename from the third party software used to generate the 
report. This path and file name will not match that in the 
Planogram Documents Directory - although Macro Space 
Planning will still be able to retrieve it. 

The Planogram Publish Directory 
The Planogram Publish directory is used as the starting point for the sub-directories used 
to hold published planograms. The precise structure of those sub-directories will depend 
on setting in the Output Tab on the Planogram Publishing Configuration dialog box in 
the Admin Module. 
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The Planogram Root Directory 
The Planogram Root directory is the Root directory for planograms imported from third 
party software. This directory is not used in the standard implementation. Planograms 
can only be imported via the Planogram Import module. 

Note: the Planogram Import Module is found in the APPS 
directory of a standard install. 

The Root Directory 
The Root Directory holds files that are essential to the operation of the software. Most are 
directly referenced by the software and do not need the path specified by the Root 
directory. 

Note: the DLL's are dependency DLL's referenced by the 
software. Acad.err, DLINE.LSP, and ACAD.fas are 
referenced by AutoCAD. 

The RFBin Directory 
The RFBin Directory holds files from Store Manager that have been marked for deletion, 
but not yet purged from the database.  
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When files are marked for deletion in Store Manager the physical files and directories are 
moved from under the Store Root to the RFBin. At the same time, the files are renamed 
from Filename.dwg to <FIL_ID>.dwg. (The FIL_ID is the primary key in the database). 
If the files are un-deleted, they will be moved back to the Store Root and the FIL_ID 
changed back to the file name. 
If files are deleted, all entries will be removed from the database and all physical files and 
directories removed from the Windows file structure. 

Note: At present files are not being moved to the RFBin 
when marked for deletion. When purged, the physical 
directories and files are not being removed from the 
Windows file structure. 

The Sound Directory 
The Sound Directory is used to hold .wav sound files that can be used to give audible 
warnings for problems within Macro Space Management.  
The sounds are not user configurable but must be set up by Oracle using the 
AVTTB_EVENT_SOUND table in the database. 

Note: WAV files are a standard format file used for playing 
Audio only sounds. 

The Store Root and its Child Directories 
The Store Root serves as the starting point for a hierarchy of folders containing 
information on the stores within Retail Group. It must be located in a location accessible 
to all users of Macro Space Management and In-Store Space Collaboration.  

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. If installed, In-Store Space Collaboration uses 
DWF files (a special form of an AutoCAD drawing) to show 
the architectural plan for a store. This allows ISSC users to 
see where the fixtures and fittings are located relative to the 
structure of the store.  

Stores, floor and revisions are created relative to the store root. Stores are direct children 
of the store root. floors are children of their parent stores, and revisions are children of 
their parent floor. 
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As stores, floor and revisions are created, physical directories are created relative to the 
store root. 

 

When the physical directory is being created, it will be named according to the 
information in the description field of the Add Floor dialogue box. If the store, floor or 
revision is subsequently renamed, it will be renamed in the database only. In the example 
below, when the floor was created it was called Level 1 and the directory named 
accordingly. The floor has subsequently been renamed 'First Floor' and the information 
changed accordingly in the database.  
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. 

The database retains a link between the original directory name and the new name 
assigned in the description, so if the floor (or store or revision) is deleted from the 
database, the physical directory will be deleted as well.  

The Textures Directory 
The Textures Directory has two purposes: 

 It holds jpg files used to specify the materials for the floor and ceiling of the store 
in Merchandiser. These materials can be selected for use in the Merchandiser tab 
of the Configuration Module (Floor Material and Ceiling Material options). 

 

Note: At present the Configuration module attempts to 
select materials from the Image Root directory.   
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 It holds jpg files used as the basis for creating lightwave objects (lwo files) for 
fixtures. In the example below a 'wood grain' effect has been used to make a 
pallet more realistic. 

 

Note: a LWO file is a graphics file that gives a more detailed 
image than a 3DS file. The option to set up the LWO file is 
invoked in Merchandiser by right clicking on a Fixture and 
selecting 'Edit Materials'. 

The Working Directory 
The Working Directory should always be local. It stores temporary files used by the 
software.  
An example would be when products are added in Merchandiser - the temporary 
graphics used to show products as 3D boxes are held in the Working directory. 

The Files Tab 
The Files Tab contains information on two files essential to the operation of Macro Space 
Management.  

 

These files are shown in the File List.  
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Prototype Drawing File  
The Prototype Drawing file is the AutoCAD drawing that will be copied each time Store 
Manager is used to create a new drawing. It can be used to specify the default settings in 
the drawing, for example Snap and Grid spacing. 
There are two Prototype Drawings supplied with the software - one for metric and one 
for imperial drawings. The file selected should be appropriate for the units used in the 
database.  

Lin (LineType) File 
The LIN file contains information on line weights (thicknesses) used for AutoCAD 
drawings.  

Note: see the AutoCAD Help file for further information on 
modifying the information in the 'Lin' File. 

To Edit a file path, highlight the directory Name then click on the Edit button. This will 
bring up the Select File dialogue box. 

 

Browse to the new directory and click OK.  
To Add a file, click on the Add button. 

 

Type in a name and description for the new file. Browse to the new file and click OK.  

Note: there is generally no purpose in adding new files to 
the Files tab - they are not referenced by the software. 

To Delete a file, highlight the file Name then click on the Delete button  
A small dialogue box will come up asking for confirmation the directory is to be deleted.  
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Click on Yes to delete the file 

Note: Mandatory files cannot be deleted. The Prototype 
drawing and LIN files will be found in the 'Data Files' 
directory in the standard installation: C:\Program 
Files\Oracle Retail\MSM\Data Files. 

The Zones Tab 
The Zones Tab contains basic options for Zones. 

 

 Auto Close will automatically close a zone when drawing it if the user clicks 
within the Proximity of the point where drawing the zone commenced. 

 Hatch Zones determines whether different zone types are drawn with a colored 
or transparent background.  

 Hatch Over Text determines whether the Hatch Pattern will go over the top of 
any annotation. 

 Detect Clashes determines whether clashes between overlapping zones are 
highlighted during Zone placement. 

58   



The Fixturing Tab 

 Prompt for Name causes a dialogue to come up allowing zone be renamed 
locally when inserted into drawing. </p>  

Note: Only Zones on the same aliased layer can be shown as 
clashing. 

 Thicken Boundary increases the thickness of the boundary of the zone as visible 
on the drawing.  

 Flash causes the selected Zone to flash briefly when selected from the 
hierarchical tree. 

 Zoom determines whether a Zone increases in apparent size when selected. The 
physical size of the Zone does not change, only the scale it is displayed on the 
screen. Zoom only affects drawings opened in the AutoCAD environment, not in 
Merchandiser.  

 Max Zoom Scale is only active when the Zoom check box is ticked. It sets the 
amount a zone zooms when selected.  

The Fixturing Tab 
The Fixturing Tab contains a series of options primarily concerned with fixture 
placement. These options can affect how fixturing behaves in Planner, Merchandiser or 
both. 

 

 The Attributes frame specifies which features (attributes) of the fixture or fitting 
are active when it is placed into the drawing.  

 The Placement frame specifies which options are available when a fixture or 
fitting is placed into a drawing. For example, if the Clash Detection check box is 
ticked, then a warning will be given if one fixture is placed overlapping another 
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 The Connection Points frame specifies a series of options that determine how 
two fixtures/fittings with connection points join together. For example if the 
Layer Filter option check box is ticked, then fixtures or fittings on different 
aliased layers cannot be connected.  

 The Highlighting frame determines how fixtures or fittings selected via the 
Fixtures tool bar display when selected.  

 The Preview frame determines how Fixtures and Fittings will show in the 
Preview window on the Object Browser. 

 The Tooltip frame determines the information that will show when the mouse 
pointer is held over the fixture/fitting name, for example in Merchandiser. 

The Attributes Frame 
The Attributes Frame is used to set the options available for AutoCAD attributes 
assigned to an AutoCAD Block. These settings will take effect when blocks are inserted 
in the Planner module. 

 

Note: Attributes are customizable annotations specific to 
particular types of object, for example fixtures. They are 
typically assigned to an AutoCAD object using the ATTDEF 
command - generally before the block is imported into 
Macro Space Management. For more information on 
Attributes and Blocks see the AutoCAD help files.  

In the example below, the attribute is used to specify the material for the fixture. 

 
Resize Attributes results in the attribute being resized if the size of the object to which 
the attribute is attached changes. This applies to stretchable (re-sizable) blocks where the 
user can specify dimensions when the block is placed in the drawing. If this option is not 
checked then the attribute will stay the same size when the size of the object is changed. 
Rotate Attributes results in the attribute being rotated to stay in a readable orientation 
when the object to which the attribute is assigned is changed to another orientation. If 
this option is checked, the attribute will be 'flipped' so that it can be read when the block 
is rotated 180o. If the option is not checked, the attribute will appear upside down when 
rotated 180o.  
In the example below the Rotate Attributes checkbox has not been checked. When the 
block is placed in the Planner module and rotated 180o, the attribute text is upside down.  
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Prompt for Attributes results in the user being prompted to edit the attribute when the 
object is inserted. The prompt will appear in the AutoCAD command line in the Planner 
module. 

 

Note: If the Prompt for Attributes option is checked, the user 
will have to specify an attribute before the Add Fixtures 
dialogue box appears. 

The Placement Frame 
The Placement Frame is used to specify how fixtures place in the drawing. Some options 
apply to the Planner module, some to both the Planner and Merchandiser modules. 

 

The options are either selected from the drop down list, ticking or un-ticking the check 
boxes, or by using the spin controls.  
The drop-down list at the top of the frame givers the user the option to set the default for 
the Add Fixture dialogue box in the Planner module.  

 Auto Attach enables the fixture being inserted to be snapped to an existing 
fixture (providing suitable connection points exist).  

 Auto Move enables the fixture to be moved to a different position than the 
original insertion point.  

 Auto Align automatically aligns the fixture being inserted with the nearest 
existing fixture. 
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 Auto Rotate automatically requires the user to specify the rotation angle of the 
block when inserting into the drawing.  

 Auto Reinsert enables the user to insert further examples of the fixture without 
re-selecting it from the hierarchy by pressing <Return>. 

If either Auto Rotate or Auto Reinsert are selected, this will render some of the options in 
the Add Fixture dialogue box temporarily unavailable.  

 

The unavailable options are Place Fixture In-Line, Offset the Fixture, Array Fixtures, and 
Rotate Fixture. Undo is also temporarily unavailable because there are no actions to undo 
until the fixture has been placed. 
Explode Composites results in composite blocks separating into their constituent parts 
when inserted into the drawing.  

Note: This option is an MSM command and differs from the 
AutoCAD Explode command. The AutoCAD Explode 
command will explode the composite into its constituent 
parts, but will not write the individual blocks into the MSM 
database. (This requires Synchronization). The MSM 
Explode both explodes the composite into its constituent 
blocks and writes the individual blocks into the MSM 
database - synchronization is not needed.  

Display UCS Icon determines whether the Planner UCS (Universal Co-ordinate System) 
icon is displayed when fixtures are inserted. If the box is not checked, the UCS icon will 
be temporarily suppressed while a fixture is being placed. 
Prompt for Sizes activates a dialogue box that prompts the user to specify the 
dimensions for sizable fixtures. If checked, when the fixture is stretchable, it will cause a 
prompt dialogue box to appear when the fixture is placed. 
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Note: if the Prompt for Sizes checkbox is not enabled, it will 
not be possible to specify the size of stretchable fixtures 
when inserting them in the drawing. 

Angle increments sets the increments by which a fixture can be rotated during insertion 
into Planner.  

 

Clicking on the Rotate Fixture option in the Add Fixture dialogue box will bring up the 
Rotate Block dialogue box. 

 

The Angle Increments option in the Fixturing tab of the Configuration Module 
determines the increments the Relative angle will increase or decrease when the spin 
controls for Relative Angle are used. 
Size Increments sets the increments by which a fixture can be nudged during insertion.  

Note: this functionality is not working at present. 

Fixture Nudge Increment sets the amount a selected fixture is nudged in the 
Merchandiser module each time a cursor key is pressed.  
If set to 1 in an imperial database, then the fixture will be moved the equivalent of one 
inch every time a cursor key is pressed. (The equivalent would be one centimeter in a 
metric database).  

Configuration Module Components 63 



The Fixturing Tab 

Snap Radius determines how close a fixture has to be to another in the Planner Module 
before the connection points snap together. The larger the value, the greater the distance 
one fixture will snap to another from.  

Note: For fixtures to connect together, their connection 
points must have compatible settings. See Fixture Studio 
help file for more detailed information. 

The Connection Points Frame 
The Connection Points frame is used to specify details of connection points that join one 
fixture to another.  

 

The options are either selected by ticking or un-ticking the check boxes, or by using the 
spin controls.  
Gender Filter sets whether male connections can only connect to female connections, or 
whether one connection can connect to another irrespective of gender. If off, any gender 
will connect to any gender. 
Size Filter sets whether connections have to be of compatible sizes to mate, or whether 
one connection can join to another irrespective of size. If off, any size of connection will 
connect to any other size. 
Shape Filter sets whether connections have to be the same shape to mate. If off, any 
shape will connect to any other shape. 
Which filters will set will determine which connection points can connect to which - and 
which warnings display. 

 

Pointer Size is used to set the size the connection points visually appear in the Planner, 
Merchandiser and Fixture Studio environments.  
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 In Planner, the connection points will appear when the 'Attach' option is selected 
in the Add Fixture dialogue Box. 

 In Merchandiser, the connection points will appear when Connections are 
toggled On in the status bar. 

 In Fixture Studio, the connection points can be seen in the Preview Tab of the 
Block Details dialogue box - tick the 'Connection Points' check box to display 
them.  

Line Size is used to set the thickness of lines associated with connection lines in the 
Merchandiser module and in the Preview Tab of the Block Details dialogue box - tick the 
'Connection Points' check box to display them.  
Colors are used to set the color for the connection points used in the Planner and 
Merchandiser environment.  

Note: : It is recommended Neutral, Male and Female 
connection points are given different colors. 

The Connection Points Frame and Fixture Studio 
Connection points are specified within the Block Details dialogue box in Fixture Studio.  

 

The Connections tab allows users to specify the Connection Name, Type, Gender, Shape, 
Size and whether it is a default connection. 
Filters set in the Connection Points frame of the Fixturing tab in the Configuration 
Module then determine which connection points can connect with which.  
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For example, if the Gender filter is On, male connections cannot connect with other male 
connections; if the Gender filter is Off, they can. 
See the Fixture Studio Help file for more information.  

The Highlighting Frame 
The Highlighting frame has two functions: 

 It is used to specify how fixtures appear when highlighted in the drawings in the 
Planner module. 

 It is used to specify the color of the merchandisable area in Merchandiser and 
Fixture Studio  

 

The option is activated in Planner by clicking the Highlight in Drawing option in the 
fixturing toolbar - when a fixture present in the drawing is highlighted in the fixture 
hierarchy it will be highlighted in the drawing according to the selected options. 

 

Flash causes the selected Fixture to flash three times when selected from the hierarchical 
tree. 
Thicken increases the thickness of the lines denoting the fixture as visible on the 
drawing.  
Zoom determines how much a Fixture changes in apparent size when selected. The 
physical size of the Fixture does not change, only the scale it is displayed on the screen. If 
there are multiple fixtures in the drawing, the drawing will zoom until all fixtures of that 
type are visible. 
Max Zoom Scale is only active when the Zoom check box is ticked. It sets the amount a 
fixture zooms when selected.  
Merchandisable Area Color indicates the color merchandisable areas appear in the 
Preview Tab of Fixture Studio and if displayed in the Merchandiser module. 
In the example below from Fixture Studio, the Merchandisable area color has been set to 
blue. 
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The Preview Frame 
The Preview frame is used to set the order of priority that previews will display in the 
preview window in the Object Browser. 

 

Each option in the list of those available can be moved up and down in the window by 
clicking on the Up or Down buttons.  
If a direction is not available then the appropriate movement button will be grayed out.  

The Tooltip Frame 
The Tooltip Frame is used to select the tooltip that is displayed when the mouse pointer 
is held over a fixture. 

 

The required tooltip can be selected by using the scroll bar to find the required tooltip in 
the list of those available, then clicking on it to highlight it. 
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The Merchandising Tab 
The Merchandising Tab contains setting that affect how Products and Planograms are 
placed on fixtures. 

 

 The Selection frame specifies a series of options determining how fixtures are 
selected for placement of Products or Planograms.  

 The Options frame determines what tolerances will be allowed for over or 
undersize planograms when placing them – planograms outside these tolerances 
will trigger an error message.  

 The Highlight frame specifies how selected fixtures will display in the Planner 
module when the Highlight in Store option is used.  

 The Check Rules frame sets criteria by which Planograms will be filtered for 
display.  

 The Placement Rules frame determines how the planogram will be placed on the 
selected fixture. 

The Selection Frame 
The Selection frame specifies a series of options determining how fixtures are selected 
for placement of Products or Planograms.  

Note: Changes in these settings will have a considerable 
effect on how fixtures are selected. Users may wish to 
experiment to find settings that suit their requirements. 
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Fixture Selection Mode is selected from a drop down list. It only affects the Planner 
module. 

 

Standard Selection allows users to use all the usual AutoCAD selection methods, for 
example windows selection boxes and fences.  
Pick Near Position gives an additional method selection method. Providing no fixtures 
are currently selected, when the Add Product or Add Planogram buttons are clicked on 
the Object Browser, users may select fixtures to merchandise by clicking adjacent to 
them. A sequence of fixtures may be selected, the selection sequence being completed by 
right clicking. 
Vertical Category Filter enables the user to select Planograms that have previously been 
assigned to a vertical category. This allows users to select planograms that have been 
designated for placement in fixtures above floor level. 

Note: This functionality is not fully implemented 

Proximity Check sets the tolerance for the Planner cursor when Standard selection is in 
use. The larger the value, the further the user may click from a fixture and still select it. 
Always show selection dialogue controls display of the Delete Products dialogue box 
when products or planograms are deleted in the Planner module.  

 If this option is not enabled, then the dialogue box will only appear if multiple 
products or planograms are selected. Single instances of a product or planogram 
will be deleted without further confirmation.   

 If this option is enabled, then the dialogue will appear even if a single product or 
planogram is deleted. 
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Select whole planogram allows users to select a single fixture associated with a multi-
bay planogram and delete the whole planogram when the Delete Planogram command is 
used. 

Note: this functionality is not yet working. 

Highlight selected fixtures highlights fixtures in the drawing suitable for the currently 
selected planogram in the Object Browser.  

Note: this functionality is not yet working. 

Sort Left-most controls whether fixtures are populated in the sequence they are selected 
or whether they are sorted into a sequence starting with the leftmost fixture. 

 If Soft Leftmost is Off, then the fixtures will be populated in the sequence they 
are selected. 

 If Sort Leftmost is On, then the fixtures will be populated leftmost first relative to 
the front of the fixtures. 

In the diagram below, the effects can be seen of having Sort Leftmost Off and On. The 
effect of front direction can also be seen. 
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Product Tooltip specifies the type of tooltip to be displayed when a mouse cursor is 
hovered over a product in a Planner or Merchandiser Store Plan.  

 

The Options Frame 
The Options frame determines what tolerances will be allowed for planogram length 
when placing them onto fixtures before a warning is generated. It functions for both 
Planner and Merchandiser. 
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The tolerances can be set to 0 - 50% for fixtures that are both Over and Undersize for 
length relative to the selected planogram. For example, selecting -25% for undersize 
fixtures and +10% for oversize fixtures would allow a 48" planogram to be placed on 
fixtures that varied between 36" to 52.8" in length.  
Any fixtures outside this range of lengths would still trigger the Planogram Placement 
Errors dialogue box, providing the Planogram Length warning is checked in the Check 
Rules frame of the Merchandising Tab. 

 

Product Nudge Increment sets the amount a product is nudged in Merchandiser each 
time a cursor key is pressed. If set to 1 in an imperial database, then the product will be 
moved the equivalent of one inch every time a cursor key is pressed. (The equivalent 
would be one centimeter in a metric database).  
(There is no effect in the Planner environment). 

The Highlight Frame 
The Highlight frame specifies how selected merchandise will display in the Planner 
Module.  

 

The option is activated in Planner by clicking the Highlight in Drawing option in the 
fixturing toolbar - when a fixture present in the drawing is highlighted in the fixture 
hierarchy it will be highlighted in the drawing according to the selected options. 
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Flash causes the selected merchandise to flash three times when selected from the 
hierarchical tree. 
Zoom causes the merchandise to change in apparent size when selected. The physical 
size of the Fixture does not change, only the scale it is displayed on the screen. If there 
are multiple fixtures in the drawing, the drawing will zoom until all fixtures of that type 
are visible. 
Max Zoom Scale is only active when the Zoom check box is ticked. It sets the amount a 
fixture zooms when selected.  

The Check Rules Frame 
The Check Rules Frame sets criteria by which warnings will be given for Planograms 
being placed in both the Planner and Merchandiser modules.  

 

When a planogram is designed in Merchandiser or imported into the MSM database, the 
planogram definition contains information about the fixtures it is designed to be placed 
on. The check rules compare information on the fixtures selected in the drawing with the 
information on fixtures held in the planogram definition.  
If there is a difference between the selected fixtures and the defined fixtures for the 
currently active rules, a Planogram Placement Errors dialogue box will appear in both 
Merchandiser and Planner environment.  
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The check boxes generate the following warnings if selected: 
 Size is current grayed out. When it was active it turned the Size Rule On or Off in 

the Merchandiser module. 

Note: The Size Rule can be turned On or Off using the 
controls in the Merchandiser module. 

 Planogram Length, Planogram Depth and Planogram Height trigger warnings if 
the selected fixtures do not match the sizes specified in the planogram definition  

 Range triggers a warning if the Planogram to be added has properties that do not 
fall within specified temperature or weight ranges. 

Note: the Range option is currently not active in 
Merchandiser. 

 Style triggers a warning if the Planogram to be added has a specified style that 
does not match the styles for the specified fixtures. 

 Allow Multiple Profiling allows the use to add a planogram to a fixture already 
containing merchandise if the checkbox is ticked. 

Note: to be warned about multiple profiling, ensure this 
checkbox is NOT checked. 

 Split Planograms triggers a warning if a planogram has been placed on fixtures 
that are not adjacent - i.e. fixtures with a distinct gap between them and the 
planogram has not been designated as split able.  

Note: this warning does not currently operate in 
Merchandiser - although it does in the Planner module. 

The Placement Rules Frame 
The Placement Rules frame determines how the planogram will be placed on the 
selected fixtures. Some options cater for if the parameters in the planogram definition 
differ from those of the selected fixtures. 
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Detail brings up a pull down list specifying the default level of detail the planogram will 
be drawn in.  

 

 2D places a simple placeholder to represent the planogram. No shelves or 
products will drawn. 

 3D draws the shelves in the planograms but represents the products by 
placeholders on the individual shelves. 

 3D with Product Items shows the shelves with individual products drawn. 

Note: This option has a considerable impact on the amount 
of data storage capacity required. Choosing the 2D option 
will result in a significantly smaller quantity of data being 
stored than if the 3D with Product Items option is selected. 
The Detail drop down list sets the amount of default level of 
detail planograms will be drawn in. It is possible to change 
the level of detail in an individual store plan by clicking on 
the Implode or Explode  icons in the Directions and Product 
Text Toolbar. 

 

The remaining options determine what happens if the fixtures selected to place the 
planogram on differ from those specified in the planogram definition held in the 
database.  
The Extend if fixture is longer option comes into effect when planograms are shorter 
than the fixture. The two subsidiary options will be grayed out until the 'Extend if fixture 
is longer' option is selected. 

 Extend Shelves increases the shelf length (and depth) on the planogram until it 
matches that of the fixture. 

 Fill with product puts additional product onto the shelf (or fixture) for the 
additional length (and depth) of the fixture. 

Truncate will shorten the Planogram length to that of the fixture if it is longer. This 
means that both the shelves and their associated products will be reduced for both length 
and depth as required. 
Nearest Slot will change the slot heights in the Planogram to match that of the fixture if 
the fixture does not permit the slot heights specified in the Planogram.  
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Nearest Shelf Angle will change the shelf angles in the Planogram to match those of the 
fixture if the fixture does not permit the shelf angle specified in the Planogram.  

Note: the functionality for extending and truncating 
planograms is not yet fully implemented. 

The Merchandiser Tab 
The Merchandiser Tab contains a series of options determining how things are 
displayed in the Merchandiser module.  

 

Render Mode 
This functionality is currently not enabled.  
Product Representation 
This functionality is currently not enabled.  
Express Load 
This option allows users to only load part of a Store Plan, thus maximizing operation 
speed while working in the Store Plan. More Info 
Double Sided 
This option allows for objects drawn in Planner (AutoCAD) that might have only had 
one face assigned to a side. Checking Double Sided ensures that both faces of such 
objects are drawn - although at a penalty in performance. More Info  
Lock on Tab Change 
Lock on Tab Change links current setting of the Object Browser in the Merchandiser 
Module to actions that can be carried out in the current store plan. If set to 'On' then 
fixtures and gondolas are locked against change except when the Fixturing Tab is 
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selected. Similarly, products and planograms are locked against change except when the 
Merchandising Tab is selected. 
Texture Quality 

Texture Quality sets the default Texture Quality for when a drawing is opened. The 
texture quality for a specific store plan can be adjusted using the toolbar options in 
Merchandiser. 
Ambient Light 
The Ambient Light sets the default light level when the store plan is opened. The exact 
result will depend on the number, location and type of lights positioned in a specific 
store plan. The light level for a specific store plan can be adjusted using the toolbar 
options in Merchandiser. 
Front Clipping Distance and Back Clipping Distance 
The Front Clipping Distance and Back Clipping Distance set the maximum and 
minimum distances the drawing will be visible within. These values can be reset for a 
specific store plan can be adjusted using the toolbar options in Merchandiser. More Info 
Fixture Snap 

This functionality is not enabled at present. 
Product Snap  

This functionality is not enabled at present. 
Floor Material 

This enables the user to select a jpg graphics file that will appear at repeated intervals to 
represent the floor in each store. More Info 
Ceiling Material 
This enables the user to select a jpg graphics file that will appear at repeated intervals to 
represent the ceiling in each store. More Info 
Wall Material 
This functionality is not enabled at present. 
Floor Texture Size 
This is the size that the image for the floor (and ceiling) will be drawn. The image will tile 
repetitively at that size.  
Sky Color 

This is the color that the sky will draw in the Merchandiser environment. It can be 
selected by clicking the button and selecting the color from the pallet. 
Ground Color 
This is the color that the ground will draw in the Merchandiser environment. It can be 
selected by clicking the button and selecting the color from the pallet. 

Note: This functionality is not enabled at present. 

The Express Load Option 
The Express Load option on the Merchandiser tab allows selection of specified parts of 
the store plan to be displayed. This speeds up movement and operations within the 
drawing as a smaller quantity of data is being manipulated. It is selected by ticking the 
check box on the Merchandiser tab. 
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When a store plan is selected in Merchandiser, the Express Load dialog box will appear.  

 

This gives control what is displayed. The user can display the following for any selected 
zone: 

 Fixtures 
 Fixtures and Shelves 
 Fixtures, Shelves and Products  
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On clicking OK, the store plan will open with only the selected zones displayed. 

The Double Sided Option 
The Double Sided option allows for objects drawn in Planner (AutoCAD) that might 
have only had one face assigned to a side. Checking Double Sided ensures that both faces 
of such objects are drawn. 

 

To understand this, consider this example of products placed inside a bin. The Front 
Clipping Plane has been advanced until it cuts into the image. The products are drawn in 
the form of a cube but only the outside faces of the cube are normally drawn. Here, use of 
the Front Clipping Plane has revealed the inside faces of the cube - which have been 
drawn without any detail. 

 

The software usually correctly determines which are the outside and inside faces of an 
object. Sometimes it can error. For example, the outside [normally visible] faces could be 
drawn without detail and be invisible to users.  
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In the example below, the left hand image shows the 'double sided' option set to Off, 
with some faces of the fixture not being rendered correctly. The right hand image shows 
the 'double sided' option set to On, with all faces of the fixture drawn double sided, thus 
avoiding the error. However, because more faces are being rendered, this requires more 
processing capacity from the computer.  

 

The setting for the 'Double Sided' option is saved to the Registry and is thus specific to 
individual computers. It is recommended that users set 'Double Sided' to Off unless there 
are problems rendering objects in a specific store plan. 'Double Sided' can then be set to 
On - once Merchandiser has been restarted objects will draw fully in that store plan. 

Note: The AutoCAD Rendering Preferences Option dialog 
box provides a similar option called 'Force 2-sided' for the 
Planner Module. This can be accessed by using the 'RPREF' 
 command in the command line.  
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Front and Back Clipping Distance 
The Front Clipping Plane and Back Clipping Plane are used to set the front and back 
distances beyond which detail is not visible. Reducing the area that is drawn in the store 
plan improve the performance in rendering the drawing. 
Front Clipping Plane 
The Front Clipping Plane determines the distance in front of the user's view point detail 
will start being drawn from. In the left hand image the Front Clipping Plane is in front of 
the fixtures being viewed. In the right hand image, the Front Clipping Plane distance has 
been increased. It has now reached the products on the top shelf of the end cap. Part of 
those products are inside the Front Clipping Plane and are not being drawn.   
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Back Clipping Plane 
The Back Clipping Plane determines the maximum distance from the user's view point 
detail will start being drawn from. In the example below, the Back Clipping Plane is 
behind the fixtures and all of the fixtures are visible. 

 

In the example below, the Back Clipping Plane has been brought closer and fixtures 
further to the rear are no longer included in the view being drawn. 
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Floor and Ceiling Materials 
Floor and Ceiling Materials can be assigned, allowing the store to look more realistic. In 
the example below, a tile material has been assigned to the floor.  

 

Floor and Ceiling materials are assigned by clicking on the appropriate button in the 
Merchandiser tab and navigating to the required image.  

 

Note: Valid image types are .jpg and .bmp  

The size the image will appear is governed by the Floor Texture size. If set to 8" x 4" the 
image will tile repetitively at this size. 
Ceiling Height 
The ceiling will draw at the height specified in the AVTTB_LEVELTYPE table in the 
database. In the example below, the ceiling is set to draw at a height of 168" (14ft). 
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The ceiling is visible when viewed from below, but not when viewed from above. 

The Profiles Tab 
The Configuration Module allows users to specify a large number of local settings to suit 
their preferences as to how their local copy of the software should operate. These settings 
are stored in Profiles. The user can define multiple profiles and readily switch between 
them - thus changing from one configuration of the software to another. This is done via 
the Profiles Tab. 

 

The individual settings for each Profile are stored in the Registry on each computer. 
Information is stored in two places within the Registry: 

 HKEY_LOCAL_MACHINE\SOFTWARE\AVT\Retail Focus 5 
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 HKEY_CURRENT_USER\Software\AVT\Retail Focus 5 
Within these locations, data is stored in named profiles. In the example below, data is 
held for three profiles: 

 Live Database 
 Test Database 
 v5 Default 

 

Each folder then contains individual settings for one aspect of MSM. For example, the 
Merchandising folder holds the settings from the Merchandising tab in the Configuration 
module. 
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Note: some of these values are stored as bit wise variables - 
these should be set through the Configuration module and 
not directly in the registry. 

The Profiles Tab 
Each Profile contains a defined set of preferences that have been set using the 
Configuration Module. The Profile in use is known as the Current profile. As changes are 
made to the Configuration Module, the modifications are stored in the current profile. 
Oracle Retail Macro Space Management allows users to store multiple profiles, allowing 
them to switch from one set of standard settings to another. 

 
All currently available profiles will be listed in the text pane. 
Set Current makes a highlighted profile current.  

Note: the new profile will not take effect until the software 
has been closed and restarted. 

Add takes a copy of the current profile and stores it under a different name. It also makes 
the new profile current.  
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Delete deletes the highlighted profile.  

Note: If the profile to be deleted is current, it cannot be 
deleted – another profile has to be set to current first.  

 

Before the profile can be deleted, it has to be conformed via a small dialogue box. 

 

Export Profile exports the highlighted profile to the Export directory, putting up a 
confirmatory message at the same time. 

 

Note: The Export directory is specified in the directories tab. 

Current Configuration Profile 
The Current Configuration Profile is shown above the tabs. Changes made to 
configuration options are stored in this profile.  

 

The current profile can be changed in the Profiles tab.  
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Switching Profiles 
Each Profile holds a complete user specific list of settings for Macro Space Management. 
This allows users to swap from one list of settings to another at the click of a button.  

 

In order to do this, highlight the profile it is wished to change to and click the Set Current 
button.  
In the above example, the user is in the process of switching from the Live Database 
(shown as the Current Configuration Profile) to the Test Database. 

Note: the new profile will not take effect until the software 
has been closed and restarted. 
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